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] Overview

Signal Processing Toolbox Product Description

Perform signal processing and analysis

Signal Processing Toolbox provides functions and apps to generate, measure, transform,
filter, and visualize signals. The toolbox includes algorithms for resampling, smoothing,
and synchronizing signals, designing and analyzing filters, estimating power spectra, and
measuring peaks, bandwidth, and distortion. The toolbox also includes parametric and
linear predictive modeling algorithms. You can use Signal Processing Toolbox to analyze
and compare signals in time, frequency, and time-frequency domains, identify patterns
and trends, extract features, and develop and validate custom algorithms to gain insight
into your data.

Key Features

+ Signal transforms including fast Fourier transform (FFT), short-time Fourier
transform (STFT), and Hilbert transform

+ FIR and IIR filter design and analysis

+  Measurements such as transition and pulse metrics, band power, bandwidth, and
distortion

*  Power spectrum estimation algorithms and data windowing functions
+ Statistical signal measurements such as autocorrelation and cross-correlation
* Linear prediction and parametric time series modeling

+ Waveform and pulse generation and data resampling functions
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* “Representing Signals” on page 2-2

+ “Waveform Generation: Time Vectors and Sinusoids” on page 2-4
* “Impulse, Step, and Ramp Functions” on page 2-6
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Representing Signals

In this section...

“Numeric Arrays” on page 2-2

“Vector Representation” on page 2-2

Numeric Arrays

The central data construct in the MATLAB environment is the numeric array, an ordered
collection of real or complex numeric data with two or more dimensions. The basic data
objects of signal processing (one-dimensional signals or sequences, multichannel signals,
and two-dimensional signals) are all naturally suited to array representation.

Vector Representation

MATLAB represents ordinary one-dimensional sampled data signals, or sequences, as
vectors. Vectors are 1-by-n or n-by-1 arrays, where n is the number of samples in the
sequence. One way to introduce a sequence is to enter it as a list of elements at the
command prompt. The statement

x=1[437-91];

creates a simple five-element real sequence in a row vector. Transposition turns the
sequence into a column vector

X = X";
x:
4
3
7
-9
1

Column orientation is preferable for single channel signals because it extends naturally
to the multichannel case. For multichannel data, each column of a matrix represents one
channel. Each row of such a matrix then corresponds to a sample point. A three-channel
signal that consists of X, 2X, and X/m is

y = [x 2*x x/pi]
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4.0000
3.0000
7.0000
-9.0000
1.0000

8.0000
6.0000
14.0000
-18.0000
2.0000

1.2732
0.9549
2.2282
-2.8648
0.3183

If the sequence has complex-valued elements, the transpose operator takes the conjugate
of the sequence elements. To transform a complex-valued row vector into a column vector

without taking conjugates, use the . " or non-conjugate transpose:

X
X

[1-1 3+i 2+3*i 4-2*i]; % 1-by-4 vector

X.";

% 4-by-1 vector
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Waveform Generation: Time Vectors and Sinusoids

2-4

Most toolbox functions require you to begin with a vector representing a time base.
Consider generating data with a 1000 Hz sample frequency, for example. An appropriate
time vector is

t = (0:0.001:1)";

where the MATLAB® colon operator (:) creates a 1001-element row vector that
represents time running from O to 1 seconds in steps of 1 ms. The transpose operator (%)
changes the row vector into a column; the semicolon (;) tells MATLAB to compute, but
not display, the result.

Given t, you can create a sample signal y consisting of two sinusoids, one at 50 Hz and
one at 120 Hz with twice the amplitude.

y = sin(2*pi*50*t) + 2*sin(2*pi*120*t);

The new variable y, formed from vector t, is also 1001 elements long. You can add
normally distributed white noise to the signal and plot the first 50 points:

yn =y + 0.5*randn(size(t));
plot(t(1:50),yn(1:50))
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Impulse, Step, and Ramp Functions

Since MATLAB® is a programming language, an endless variety of different signals
is possible. Here are some statements that generate a unit impulse, a unit step, a unit
ramp, and a unit parabola.

t = (-1:0.01:1)";
impulse = t==0;
unitstep = t>=0;
ramp = t_*unitstep;

quad = t.~2_*unitstep;

All of these sequences are column vectors that inherit their shapes from t. Plot the
sequences.

plot(t,[impulse unitstep ramp quad])

2-6



Impulse, Step, and Ramp Functions
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Generate and plot a square wave with period 0.5 and amplitude 0.81.

sqwave = 0.81*square(4*pi*t);
plot(t,sqgwave)
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Multichannel Signals

Multichannel Signals

Use standard MATLAB array syntax to work with multichannel signals. For example, a
multichannel signal consisting of the last three signals generated above is

z = [ramp_sig quad_sig sq_wave];

You can generate a multichannel unit sample function using the outer product operator.
For example, a six-element column vector whose first element is one, and whose
remaining five elements are zeros, is

a = [1 zeros(1,5)]";

To duplicate column vector a into a matrix without performing any multiplication, use
the MATLAB colon operator and the ones function:

c = a(:,ones(1,3));

2-9
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Common Periodic Waveforms

2-10

The toolbox provides functions for generating widely used periodic waveforms:

sawtooth generates a sawtooth wave with peaks at 1 anda period of 2T An

optional width parameter specifies a fractional multiple of 2T at which the signal
maximum occurs.

square generates a square wave with a period of 2T An optional parameter
specifies the duty cycle, the percent of the period for which the signal is positive.

To generate 1.5 seconds of a 50 Hz sawtooth wave with a sample rate of 10 kHz and plot
0.2 seconds of the generated waveform, use

fs = 10e3;

t = 0:1/Ffs:1.5;

X = sawtooth(2*pi*50*t);
plot(t,x)

axis([0 0.2 -1 1]
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Common Aperiodic Waveforms

2-12

The toolbox also provides functions for generating several widely used aperiodic
waveforms:

+ gauspuls generates a Gaussian-modulated sinusoidal pulse with a specified time,
center frequency, and fractional bandwidth. Optional parameters return in-phase and
quadrature pulses, the RF signal envelope, and the cutoff time for the trailing pulse
envelope.

* chirp generates a linear, log, or quadratic swept-frequency cosine signal. An optional
parameter specifies alternative sweep methods. An optional parameter, phi, allows
initial phase to be specified in degrees.

To compute 2 seconds of a linear chirp signal with a sample rate of 1 kHz that starts at
DC and crosses 150 Hz at 1 second, use:

t
y

0:1/1000:2;
chirp(t,0,1,150);

Plot the spectrogram of the chirp.

spectrogram(y,256,250,256,1000, "yaxis®)
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Use gauspuls to plot a 50 kHz Gaussian RF pulse with 60% bandwidth, sampled at a

rate of 1 MHz. Truncate the pulse where the envelope falls 40 dB below the peak.

tc = gauspuls(“cutoff”,50e3,0.6,[],-40);
t = -tc : le-6 : tc;

yi = gauspuls(t,50e3,0.6);

plot(t,yi)

2-13
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The pulstran Function

The pulstran Function

The pulstran function generates pulse trains from either continuous or sampled
prototype pulses. The following example generates a pulse train consisting of the sum of
multiple delayed interpolations of a Gaussian pulse. The pulse train is defined to have a
sample rate of 50 kHz, a pulse train length of 10 ms, and a pulse repetition rate of 1 kHz;
D specifies the delay to each pulse repetition in column 1 and an optional attenuation for
each repetition in column 2. The pulse train is constructed by passing the name of the
gauspuls function to pulstran, along with additional parameters that specify a 10 kHz
Gaussian pulse with 50% bandwidth:

T = 0:1/50e3:10e-3;

D = [0:1/1e3:10e-3;0.8.~(0:10)]";

Y = pulstran(T,D, "gauspuls®,10e3,0.5);
plot(T,Y)

2-15
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The Sinc Function

The Sinc Function

The sinc function computes the mathematical sinc function for an input vector or
matrix ¥. Viewed as a function of time, or space, the sinc function is the inverse Fourier

transform of the rectangular pulse in frequency centered at zero of width 2T and unit
height. The following equation defines the sinc function:

sinmx _ 1 / .
X 2T J

The sinc function has a value of 1 when ¥ is equal to zero, and a value of S TX]/TTX £4y.

all other elements of .

To plot the sinc function for a linearly spaced vector with values ranging from =3 to 2,
use the following commands:

x = linspace(-5,5);
y = sinc(x);
plot(x,y)

grid

2-17
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The Dirichlet Function

The Dirichlet Function

The function diric computes the Dirichlet function, sometimes called the periodic sinc
or aliased sinc function, for an input vector or matrix X. The Dirichlet function is defined
by

sin (Nx/2) )
—_— X F ZR.II{,
D(x) = 4 Nsin(x/2) E=0%12%2 %3, ..

(-1)¥¥-1 ¥ = 2mk,

where NV is a user-specified positive integer. For N odd, the Dirichlet function has

a period of 2 ; for IV even, its period is 47 . The magnitude of this function is 1/N

times the magnitude of the discrete-time Fourier transform of the N -point rectangular
window.

To plot the Dirichlet function between 0 and 4T for N =7 and NV =8 yse
x = linspace(0,4*pi,300);

subplot(2,1,1)

plot(x/pi,diric(x,7))

title("'N = 77)

subplot(2,1,2)

plot(x/pi,diric(x,8))

title("N = 87)
xlabel ("x 7/ \pi®)

2-19
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Working with Data

Data Precision

All Signal Processing Toolbox functions accept double-precision inputs. If you input
single-precision floating-point or integer data types, you should not expect to receive
correct results and in many cases, an error will occur. DSP System Toolbox™ and Fixed-
Point Designer™ products enable single-precision floating-point and fixed-point support
for most dfi It structures.

2-21
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Algorithm development for Signal Processing Toolbox functions has drawn heavily upon
the references listed below. All are recommended to the interested reader who needs to
know more about signal processing than is covered in this manual.
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* “Filter Design Process Overview” on page 3-2
+ “Design a Filter Using fdesign” on page 3-3
* “Design a Filter Using Filter Builder” on page 3-8
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Filter Design Process Overview

3-2

Note: You must have the Signal Processing Toolbox installed to use fdesign and
filterBuilder. Advanced capabilities are available if your installation additionally
includes the DSP System Toolbox license. You can verify the presence of both toolboxes
by typing ver at the command prompt.

Filter design through user-defined specifications is the core of the fdesign approach.
This specification-centric approach places less emphasis on the choice of specific filter
algorithms, and more emphasis on performance during the design a good working filter.
For example, you can take a given set of design parameters for the filter, such as a
stopband frequency, a passband frequency, and a stopband attenuation, and— using
these parameters— design a specification object for the filter. You can then implement
the filter using this specification object. Using this approach, it is also possible to
compare different algorithms as applied to a set of specifications.

There are two distinct objects involved in filter design:

* Specification Object — Captures the required design parameters of a filter
+ Implementation Object — Describes the designed filter; includes the array of
coefficients and the filter structure

The distinction between these two objects is at the core of the filter design methodology.
The basic attributes of each of these objects are outlined in the following table.

Specification Object Implementation Object
High-level specification Filter coefficients
Algorithmic properties Filter structure

You can run the code in the following examples from the Help browser (select the code,
right-click the selection, and choose Evaluate Selection from the context menu), or you
can enter the code on the MATLAB command line. Before you begin this example, start
MATLAB and verify that you have installed the Signal Processing Toolbox software. If
you wish to access the full functionality of fdesign and filterBuilder, you should
additionally obtain the DSP System Toolbox software. You can verify the presence of
these products by typing ver at the command prompt.
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Design a Filter Using fdesign

Use the following two steps to design a simple filter.

1 Create a filter specification object.

2 Design your filter.
Design a Filter in Two Steps

Assume that you want to design a bandpass filter. Typically a bandpass filter is defined
as shown in the following figure.

ag. (dB)
4
ar T T Amss T
AS['I'IN Ast-:-p‘-_?
} f g Lo
. Fsmm Fpass1 FpassE FstDpE S f(Hz)

In this example, a sampling frequency of Fs = 48 kHz is used. This bandpass filter has
the following specifications, specified here using MATLAB code:

A_stopl = 60; % Attenuation in the first stopband = 60 dB
F _stopl = 8400; % Edge of the stopband = 8400 Hz

F_passl = 10800; % Edge of the passband = 10800 Hz

F_pass2 = 15600; % Closing edge of the passband = 15600 Hz
F_stop2 = 18000; % Edge of the second stopband = 18000 Hz
A_stop2 = 60; % Attenuation in the second stopband = 60 dB

A pass = 1; % Amount of ripple allowed in the passband = 1 dB

In the following two steps, these specifications are passed to the fdesign.bandpass
method as parameters.

Step 1

3-3
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To create a filter specification object, evaluate the following code at the MATLAB
prompt:

d = fdesign.bandpass

Now, pass the filter specifications that correspond to the default Specification
— fstl,fpl,fp2,fst2,astl,ap,ast2. This example adds fs as the final input
argument to specify the sampling frequency of 48 kHz.

>> BandPassSpecObj = ...
fdesign.bandpass("Fstl,Fpl,Fp2,Fst2,Astl,Ap,Ast2",
F_stopl, F_passl, F_pass2, F_stop2, A_stopl, A_pass,
A_stop2, 48000)

Note: The order of the filter is not specified, allowing a degree of freedom for the
algorithm design in order to achieve the specification. The design will be a minimum
order design.

The specification parameters, such as Fstopl, are all given default values when
none are provided. You can change the values of the specification parameters after
the filter specification object has been created. For example, if there are two values
that need to be changed, Fpass2 and Fstop2, use the set command, which takes
the object first, and then the parameter value pairs. Evaluate the following code at
the MATLAB prompt:

>> set(BandPassSpecObj, "Fpass2®, 15800, "Fstop2", 18400)
BandPassSpecObj is the new filter specification object which contains all the
required design parameters, including the filter type.

You may also change parameter values in filter specification objects by accessing
them as if they were elements in a struct array.

>> BandPassSpecObj .Fpass2=15800;

Step 2

Design the filter by using the design command. You can access the design methods
available for you specification object by calling the designmethods function. For
example, in this case, you can execute the command

>> designmethods(BandPassSpecObj)
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Design Methods for class
fdesign.bandpass (Fstl,Fpl,Fp2,Fst2,Astl,Ap,Ast2):

butter

chebyl

cheby?2

ellip

equiripple

kaiserwin

After choosing a design method use, you can evaluate the following at the MATLAB
prompt (this example assumes you've chosen 'equiripple’):

>> BandPassFilt = design(BandPassSpecObj, “equiripple®)
BandPassFilt =

FilterStructure: "Direct-Form FIR"®
Arithmetic: “"double”
Numerator: [1x44 double]
PersistentMemory: false

If you have the DSP System Toolbox installed, you can also design your filter with
a filter System object™. To create a filter System object with the same specification
object BandPassSpecObj, you can execute the commands

>> designmethods(BandPassSpecObj, - . .
"SystemObject” ,true)

Design Methods that support System objects for class
fdesign.bandpass (Fstl,Fpl,Fp2,Fst2,Astl,Ap,Ast2):

butter
chebyl
cheby?2
ellip
equiripple
kaiserwin
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>> BandPassFiltSysObj = design(BandPassSpecObj, - - -
"equiripple”,"SystemObject” ,true)

System: dsp.-FIRFilter

Properties:
Structure: "Direct form*®
NumeratorSource: "Property”
Numerator: [1x44 double]
InitialConditions: O
FrameBasedProcessing: true

Show Fixed-point properties

Available design methods and design options for filter System objects are not
necessarily the same as those for filter objects.

Note: If you do not specify a design method, a default method will be used. For
example, you can execute the command

>> BandPassFilt = design(BandPassSpecObj)
BandPassFilt =

FilterStructure: "Direct-Form FIR"
Arithmetic: “double*
Numerator: [1x44 double]
PersistentMemory: false
and a design method will be selected automatically.

To check your work, you can plot the filter magnitude response using the Filter
Visualization tool. Verify that all the design parameters are met:

>> fvtool(BandPassFilt) %plot the filter magnitude response

If you have the DSP System Toolbox installed, the Filter Visualization tool produces
the following figure with the dashed red lines indicating the transition bands and
unity gain (0 in dB) over the passband.
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Design a Filter Using Filter Builder

3-8

Filter Builder presents the option of designing a filter using a GUI dialog box as
opposed to the command line instructions. You can use Filter Builder to design the same
bandpass filter designed in the previous section, “Design a Filter Using fdesign” on page

3-3

Design a Simple Filter in Filter Builder

To design the filter using the Filter Builder GUI:

1

Type the following at the MATLAB prompt:

filterBuilder

Select Bandpass filter response from the list in the dialog box, and hit the OK
button.

Enter the correct frequencies for Fpass2 and Fstop2, then click OK. Here the
specification uses normalized frequency, so that the passband and stopband edges
are expressed as a fraction of the Nyquist frequency (in this case, 48/2 kHz). The
following message appears at the MATLAB prompt:

The variable "Hbp® has been exported to the command window.
If you display the Workspace tab, you see the object Hbp has been placed on your
workspace.

To check your work, plot the filter magnitude response using the Filter Visualization
tool. Verify that all the design parameters are met:

fvtool (Hbp) %plot the filter magnitude response



Design a Filter Using Filter Builder
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Note that the dashed red lines on the preceding figure will only appear if you are
using the DSP System Toolbox software.

3-9






Filter Design with the Filter Designer

“Introduction” on page 4-2

“Designing the Filter” on page 4-3

“Analyzing the Filter” on page 4-7

“Designing Additional Filters” on page 4-9

“Viewing and Annotating the Filter” on page 4-10
“Exporting Filters from Filter Designer” on page 4-16

“Designing Filters Using Command Line Functions” on page 4-20




4 Filrer Design with the Filter Designer App

Introduction

4-2

This section describes how to graphically design and implement digital filters using
Signal Processing Toolbox. Filter design is the process of creating the filter coefficients
to meet specific frequency specifications. Filter implementation involves choosing and
applying a particular filter structure to those coefficients. Only after both design and
implementation have been performed can your data be filtered.

This section includes a brief discussion of applying the completed filter design and filter
implementation using MATLAB command line functions, such as Filter.



Designing the Filter

Designing the Filter

This section is a step-by-step introduction to using the Filter Designer app to design an
octave-band filter. An octave is the interval between two frequencies having a ratio of
2:1. An octave-band filter is a bandpass filter with high cutoff frequency approximately
twice that of the low cutoff frequency. The class of an octave filter is determined by its
allowable passband ripple and its stopband attenuation. Refer to the ANSI S1.11-2004
standard for more information.

1 Start the app from the MATLAB command line.
filterDesigner

The app opens with a default filter. Its filter information is summarized in the upper
left (Current Filter Information) and its filter specifications are depicted in the
upper right. In addition to displaying filter specification, this upper right pane
displays filter responses and filter coefficients.

) Fitter Design & Analysis Tool - [untitled.fda] =10l x|
Fle Edt Analyss Targets View Window Help
DeHSR (2L X |DHNNH- +0 BiLOREN
— Current Fiter Informeati — Fiter
Wag (dB)
Structure: Direct-Form FIR i
Orck 50 0 Ases
Staplz Y T i T
Source: Designed
Asiop
t
Store Fier ) S For2 " FiHz)
Fiter Manager
2 T — Fiter Ordler Frequency Spec — Magntude
& |Lowpass - " specify order. [10 Urits: IHz | Units: |.15 =
=3
= (| el 5
B Highpass
| ~ sangy & Minimum order Fs: 000 . —
ot andpass s
" Bandstop COpfons— | Fpass [ps00 o B0
_. ' |ifferentiator -] || oensty Factar. [E0 aop fmm
@ | Design Method.
s=ml|| © R [Butierwortn d
28
@ & FR [Equiripple B
[Ready

The bottom half of the app shows the Filter Design panel, where you specify the
filter parameters. Other panels, such as Import filter from workspace and Pole/Zero
Editor, which you access with the buttons on the lower left, are also displayed in this
area. If you have other products installed, you may see additional buttons.
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Note that when you open the app, Design Filter is not enabled. You must make

a change to the default filter design in order to enable Design Filter. This is true
each time you want to change the filter design. Changes to radio button items or
drop down menu items such as those under Response Type or Filter Order enable
Design Filter immediately. Changes to specifications in text boxes such as F's,
Fpass, and Fstop require you to click outside the text box to enable Design Filter.

2 Inthe Response Type pane, select Bandpass.

In the Design Method pane, select IIR, and then select Butterworth from the
selection list.

— Responze Type

r

Lowpass

[ |

C Highpass
{* Bandpass
" Bandstop

C ID\ﬂerentiatur 'l

(— Design Method

% IR [Butterwortn ‘l
C PR |Equiripple ‘l

4  For the Filter Order, select Specify order, and then enter 6.

Fitter Creder
% Specify order: E

" Minimum order

5 Set the Frequency Specifications as follows:

Parameter Setting Description

Units Hz Units for the parameters

Fs 48000 Sampling frequency

Fcl 22 First cutoff frequency (i.e., the frequency
preceding the passband at which the
magnitude response is 3 dB below the
passband gain)

4-4



Designing the Filter

Parameter Setting

Description

Fec2 45

passband gain)

Second cutoff frequency (i.e., the frequency
following the passband at which the
magnitude response is 3 dB below the

__Freguency Specifications
IInit=z: IHz j
Fs: j15000
Fc1: l22—
Fc2: |=15—

__ Magnitude Specifications

The attenustion st cutaff
frequencies iz fixed at 3 dB

[half the pazshand povwer)

6 After specifying the filter design parameters, click the Design Filter button at the

bottom of the design panel to compute the filter coefficients. The display updates to
show the magnitude response of the designed filter.

— Magnitude Response (dB)

Magnitucke (dB}

Frequency (kHz)
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Notice that the Design Filter button is disabled after you compute the coefficients
for your filter design. This button is enabled again if you make any changes to the
filter specifications.

7 Click the Store Filter button.

— Current Fitter Infarmation

Structure:  Direct-Form I,
Second-Order Section:

Order: &
Sections: 3
Stable: Yes

Source: Designed

=tare Fitter ... . |

&3

Fitter Manager ...

8 In the Store Filter dialog, change the filter name to Bandpass Butterworth-1 and
click OK to save the filter in the Filter Manager.

I xd

Enter filker name to b stored in the Filker Manager

Butterworth-1

Ok Cancel |




Analyzing the Filter

Analyzing the Filter

After designing the filter, you can view the following filter responses in the display region
by clicking on the associated toolbar button or by selecting the desired response from the
Analysis menu.

Response Toolbar Button Image
Filter specifications E|

Magnitude response

Phase response

Magnitude and Phase responses

Group delay

#® B2 E

Phase delay

e
Impulse response m
Step response i
Pole-zero plot a5
Filter coefficients [l;.,g]

Filter information

Note: Other analyses are available if you have the DSP System Toolbox product
installed.

1 Examine the displayed magnitude response of the filter.

2 Display other responses, as desired. Click the appropriate buttons, shown in the
table above or select the desired response from the Analysis menu.

3 Click the Filter coefficients button to display the filter coefficients.
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__Filtet Coefficients

Section #1

Numerator:

1

u]

-1
Denominhator:

1

0_8330156882200398
0. 0E4E738049556033E2
Gairn:
0.14070Z14034938651




Designing Additional Filters

Designing Additional Filters

You have designed one of the bands of an octave filter bank. This section shows you how
to design and save the other nine bands. The following table defines the parameters for

the remaining bands. Note that all of the bands use these parameters: Bandpass, IIR —
Butterworth , order = 6, Fs = 48000 Hz .

Fcl Fc2 Filter Name

45 89 Bandpass Butterworth-2
89 178 Bandpass Butterworth-3
178 355 Bandpass Butterworth-4
355 708 Bandpass Butterworth-5
708 1413 Bandpass Butterworth-6
1413 2818 Bandpass Butterworth-7
2818 5623 Bandpass Butterworth-8
5623 11220 Bandpass Butterworth-9
11220 22387 Bandpass Butterworth-10

1 Using the parameters listed in the table above, for each table row, set the
appropriate the Fel and Fe2 values.

O b WD

Design the filter by clicking the Design Filter button.
Click Store Filter to save the filter.

Repeat these steps until all 10 filters are designed and stored.

Change the name to the appropriate filter name shown in the table above.
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Viewing and Annotating the Filter

4-10

In this section...

“Viewing the Filter in FVTool” on page 4-10
“Using FVTool for Annotation” on page 4-14

Viewing the Filter in FVTool

This section teaches you how to use the Filter Visualization Tool (FVTool) to view the
octave-band filter. It also describes how to annotate your filter.

1 Click the Filter Manager button to display the Filter Manager, which lists your
saved filters.

i

Bandpass Butteryarth-1 :I EI
Bandpazs Butterwarth-2

Eandpazs Buttervwarth-3 —
Bandpass Buttervworth-4 il

Eandpazs Buttervwarth-5
Eandpass Buttervwwarth-6
Bandpass Buttervworth-7
Eandpazs Buttervwarth-5
Eandpass Buttervwarth-2
Bandpass Buttervwarth-10

=
Current fitter: Bandpazs Butterworth-10
[ Edit currert fitter

Cascade Rename Remove | FTool |

Close | Help |

2 Press Ctrl+click on each filter name to select all the filters, and then click FVTool.
FVTool opens with the filter responses overlaid for easy comparison. (If you want to
view a single filter in FVTool, click the Full View Analysis button when that filter
is shown in the app’s display panel or select View > Filter Visualization Tool).



Viewing and Annotating the Filter

3 Change the x-axis scale to logarithmic by selecting Analysis > Analysis
Parameters to display the Analysis Parameters dialog.

4 Change the Frequency Scale to Log.

=101]

__ Magnitude Response (dB)

[T Mormslized Freguency

Frequency Scale:
Frequency Range: I[EI, F=f2] A I

Murnkbet of Paints: 192
Freguency’ Yector: E 00039216 0
Magnitude Display: IMagn'rtude vI

[~ Mormalize Magnitude to 1 (0 dE)

Save as Default | Restare Qriginal Defauts I
0]34 | Cancell Help I .ﬂ-.ppl':.-'l
5 Click OK.
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) Filter Visualization Tool - Figure 1: Magnitude Response (dB) - |EI|5|
File Edit Analysis Insert View Debug Desktop Window Help ™ | A X

DaR|kOTNN\N\Nu 2R oX|BE||lgs O
RN # 40 B

IMagnitude Response (dB)

Hﬁ'wﬁﬁ

T
R

AP @ PRI
=

IMagnitude (&)

Frequency (kHz )

A

Click the Legend button EI to turn on the legend, which you can drag to the
desired location.
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Viewing and Annotating the Filter

_i0] I

A x

) Filter Visualization Tool - Figure 1: Magnitude Response (dB)
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10’
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7 Click the Legend button again to turn off the legend.

Use the Zoom button 2 and drag a rectangle around the first few passbands to

zoom 1n.
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4-14

Magnitucke Res ponsa (dB)
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8 e
Click the Restore Default View button to return to the full view.

9 Display other responses, as desired. (The FVTool Analysis toolbar buttons and
Analysis menu are the same as in Filter Designer. See “Analyzing the Filter” on
page 4-7 for descriptions of the buttons.

Using FVTool for Annotation

FVTool is also useful for doing further analysis, adding annotations, and printing.
Available annotations include adding rectangles, text boxes, arrows and lines, and
adding data tips.

Note Do not close Filter Designer at this time. You will use it in future sections.




Viewing and Annotating the Filter

Use the toolbar buttons to annotate your response plot. Add a line by clicking one of
the line buttons, and then use your mouse to draw the line on your plot.

frequency and magnitude at that point.

) Filter Visualization Tool - Figure 1: Magnitude Response (dB)
File Edit Analysis Insert Yiew Debug Cesktop window Help

Add a data tip by clicking on a plot at the desired point. The data tip shows the

=0l x|

A x
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Frequency (kHz)

3 Close FVTool by selecting File > Close.
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Exporting Filters from Filter Designer
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The Filter Designer app provides a simple way to create filter objects (dFi Its) from your
filter designs. This is particularly useful for saving your filter design to the MATLAB
workspace for use with command line functions. You can also save your filters as
MATLAB code by using File > Generate MATLAB code to run in scripts or batch files.

1 In Filter Designer, click Filter Manager and highlight only the Bandpass
Butterworth-1 filter.
2 Select File > Export.

3 Set Export to to Workspace. Set Export as to Objects. In Discrete Filter type
Hd1. Click Export to export the first filter in your filter bank to an Hd1 dfi It object
in the workspace.

~lx

— Export Ta
IWDrkspac:e j

__ Export Az
|0bjec:ts |

— Wariakle Mames

Dizcrete Filtet: F|d1

[T Cwerwrite Variahles

Exp-:ur‘tl Cloze | Help I

4 Repeat steps 1 through 3 for each of the remaining nine filters. Highlight each filter

individually to make it the active filter and change the Discrete Filter name to
match the filter number. When you finish you will have 10 dfi It objects in the
workspace.

5 Close the app by selecting File > Close.
6 On the MATLAB command line, verify that your objects were exported by using the

whos command.



Exporting Filters from Filter Designer

whos
Name Size Bytes
Hd1l 1x1
Hd10 1x1
Hd2 1x1
Hd3 1x1
Hd4 1x1
Hd5 1x1
Hd6 1x1
Hd7 1x1
Hd8 1x1
Hd9 1x1
Filtering with dfilt

1

Class

dfilt.
dfilt.
dfilt.
dfilt.
dfilt.
dfilt.
dfilt.
dfilt.
dfilt.
dfilt.

df2sos
df2sos
df2sos
df2sos
df2sos
df2sos
df2sos
df2sos
df2sos
df2sos

Attributes

Type the following on the MATLAB command line to concatenate your filter bank

filter objects into a single dfi It object.

Hd = [Hd1l Hd2 Hd3 Hd4 Hd5 Hd6 Hd7 Hd8 Hd9 Hd10];

To view the first filter, type HAd(1).
Hd(1)

ans =

FilterStructure: "Direct-Form Il, Second-Order Sections”

sosMatrix: [3x6 double]

ScaleValues: [3.40097054256801e-009;1;1;1]

PersistentMemory: false

A number of methods can be used to view and manipulate the Hd1 dfilt object. Try

the info command:

info(Hd1) % Displays filter information

Discrete-Time IIR Filter (real)

Filter Structure : Direct-Form 11, Second-Order Sections
Number of Sections : 3

Stable : Yes

Linear Phase : No

You can open FVTool from the MATLAB command line and specify display

parameters as follows.
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F = fvtool (Hd, "Analysis”, "magnitude®) % Open FVTool with
% magnitude display
set(F, "FrequencyScale®, "Log") % Change to log scale

This produces the same display as step 5 of “Viewing the Filter in FVTool” on page
4-10 above.

Now using the MATLAB command line, create some discrete white Gaussian noise
data, which you can then filter using the filter bank.

rand; % Initialize random number generator
Nx = 100000; % Number of noise data points
xw = randn(Nx,1); % Create white noise
for 1=1:10,

yw(:, )=Filter(Hd(i),xw); % Filter the white noise through
end % the entire Filter bank.

% (:,i) means all rows of column 1

Plot the filtered data.

plot(yw)



Exporting Filters from Filter Designer
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Designing Filters Using Command Line Functions

4-20

You can specify and design filters at the command line using designfilt. The use of
designTilt provides a powerful and efficient way to specify and implement digital
filters.

As an example, consider a lowpass filter for data sampled at 20 kHz. The desired
passband frequency is 1 kHz with a stopband frequency of 1.2 kHz. Limit the passband
ripple to 1 dB and require 60 dB of attenuation between the passband and stopband
frequencies.

Fs = 20000;
Fp = 1000;
Fst = 1200;
Ap = 1;
Ast = 60;

Design an equiripple FIR filter and a Butterworth IIR filter.

FIR = designfilt(" lowpassfir”, -
"PassbandFrequency*®,Fp, "StopbandFrequency” ,Fst,
"PassbandRipple”,Ap, "StopbandAttenuation” ,Ast,
"DesignMethod®, "equiripple”, "SampleRate” ,Fs);

1IR = designfilt(" lowpassiir”,
"PassbandFrequency” ,Fp, 'StopbandFrequency ,Fst,
"PassbandRipple”,Ap, "StopbandAttenuation”,Ast,
"DesignMethod®, "butter”, "SampleRate” ,Fs);

Display the magnitude responses of the filters.

hfvt = fvtool (FIR,IIR);
legend(hfvt, "FIR","1IR")
axis([0 2 -70 10]D)
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